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Learning Objectives 
This sharing focuses on the field validation rules which restrict the type of data to be entered into a 

particular field. 

The exercise prepared for this sharing session focuses on adding validation rules in a field. 

We shall be creating a table and add validation rules that will restrict the type of data which may be 

entered into a particular field. A form shall be created to see how the validation rules affect the 

process of data entries. 

 

Microsoft Access  
It is a form of relational database which can store information in multiple related tables. If it is 

organized correctly, all these multiple tables can be treated as single storage area and pull 

information electronically from different tables in whatever order which meet your needs (Lambert, 

Lambert III, & Preppernau, 2007). 
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Access consists of several objects which help to store, organize and retrieve information, such as the 

table, form, query, report and macros. 

 

The table object is the core database object which main purpose is to store information. The type of 

data which can be assigned appropriately to each field may include: 

 Data  type  Details 

1 Text Use for enter all types of data (number, special character, text , special 

characters such as &, %,= and?) for information such as like names, article 

titles, zip codes, short descriptions, etc. Its field size is 255 characters in one 
cell.  

2 Memo Use for enter all types of data (number, text, special character, etc) But its field  
size is 65535 characters in one cells include space. For instance, long texts 
like article body text, blog posts, long descriptions . (Data types in Access) 

3 Number Enter only number types (0 to 9) not include space, we can not types text 
special Characters. Example: Quantity, size, length, weight, speed, scores, 
percentages 

4 Auto number Its data type will be update automatically we can not add any number in this 
list and we can not enter deleted number. It is by default the Primary key field. 

5 Currency This data types accept only number type data with $ Rs . sign. Example: Price. 

6 Date and Time We can enter only date and time type data, Time format is (HH:MM:SS am/ 
pm), Date format is (MM-DD-YY). Examples are Birth date, order date, 
expiration date, creation date, subscription date 

7 Hyperlinks Hyper link field use for link other file / web page. 

8 Yes/No A Logical field can be displayed as Yes/No, True/False, or On/Off.  It appears 
as checkbox. 

9 OLE Object Insert any picture or any other objects (such as a spread sheet, audio file, or 
video file) its file size is 1 GB in one cell OLE (Object linking embedded. 

10 Attachment Use for insert multiples file (multiple file formats such as images or 
spreadsheet) in one cell its file size is 2 GB round about. 

11 Lookup Wizard   Links between two tables  / query / fields by relationship use option  lookup 
wizard. 
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Restricting the type of data in a field 
The data type settings restrict entries in a field to a specific type of data, such as text, numbers, or 

dates.  

Example of Field Properties 
The field properties set to control input are: 

 Allow Zero Length – when set to “No”, the field cannot be blanked, i.e. no “ ” string 

value (Zero character). 

 Field size – Set the maximum size allowed. 

 Required – When set to “Yes”, ensures that every record will have a value in this field.  

Access will show an error message and won't insert the new record if you try to insert a 

new record that has no value for a required field. 

 Input mask – It specifies that the field value must conform to the pattern set by the 

mask. Example:   

 Validation rules – The expression establishes criteria that any new or changed value 

must meet. 

Validation rules 
“A validation rule is an expression that can precisely define the information that will be accepted in 

one or several fields in a record.” (Lambert, Lambert III, & Preppernau, 2007)  

There are two basic validation rules: 

 Field validation rules - Use a field validation rule to check the value that you enter in a field 

when you leave the field. 

 Record (or table) validation rules - Use a record validation rule to control when you can 

save a record (a row in a table). Unlike field validation rules, record validation rules refer to 

other fields in the same table. You create record validation rules when you need to check 

the values in one field against the values in another (Microsoft Office, 2012). 
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You can enter validation rules for all data types except for the AutoNumber, OLE Object, and 
Attachment data types, and for Number fields set to ReplicationID (Microsoft Office, 2012). 

 

Example of field validation rules:  

 [Date2]>[Date1] means Date 2 must be later than Date 1. 

 [Birth date]<=#01/01/2012# meaning that you cannot enter a date later than or equal to 

01/01/2012. 

 [Load amount]<=20,000  shall be imposing a control over the amount of loan which should 

be less than or equal to RM20,000.  

The validation text (validation message) serves as a reminder for the user over what are the 

conditions imposed on them for a particular situation. 

You can add rules to the table or form in Design View. The exercise prepared for this sharing focuses 

on adding validation rules in a field. 
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Here is an example of validation rule applied to a field: 

 
Example of  Validation Rule and Validation Text for a field named as [Loan Amount] 

 

 

When the data input infringes the validation rule, an error message is displayed, showing the 

predetermined validation text (rule). 

Error  

massage 
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Exercise 
1. Create a table and a form. 

2. Testing on the data validation rules. 

 

I. Building a table and specifies its data type as well as the field 

properties. 

 

1. Start the MS Access program and create a new database in your desired directory and 

folder. 

2. Choose a blank database. 

3. Let’s build the following table with the fields as suggested in design mode and accept its 

name as default: 

Note:   

You need not type the description into the description field. 
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Note: 

The field name should not contain space, use underscore to separate 2 words or phrases if necessary.  

 

Hints for setting of the field properties: 
 

1. Field name: ID, Data  type: Autonumber.  

Accept the default settings. 

 

2. Field name: FirstName, Data type: Text. 
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3. Field name: LastName,  Data type: Text. 

 
Note: 

 in the “Format” properties, symbol “ > ” will print the charact ers in Uppercase,  symbol “ < ” will 

result in Lowercases. Leaving it blank  than it will accept the value as it is without any alteration.  

 

4. Field name: BirthDate,  Data type: Date & Time. 

 
Later on, you need to state in the form that the input values shall be in the format of 

“MM/DD/YY”.  

 

5. Field name: Sex,  Data type: Text/Lookup Wizard, type the inputs. 

5.1 Choose the data type as “Lookup Wizard”. 
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5.2 When the Lookup Wizard dialog box is displayed, choose “I will type in the values 

that I want”. After that, click the “Next >” button. 

 
 

4.3 Accept the values provided and click the “Next >” button.
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4.4 Accept the default value and click “Finish”.

 

4.5 Save table. 

 

6. Field name: Malaysian,  Data type: Yes/No. 

 

7. Field name: Identity_Card_Number,  Data type: Text with input mask. 

6.1 On the Field Properties Panel, click on the build button at the end of the Input Mask field.

 

Identity_Card_Number  
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6.2 When the Input Mask Wizard dialog box appeared, click to choose “Social Security 

Number” and then click the “Next >” button. 

  
 

6.3 Type the format that you have specified into the space provided for Input Mask. 

 
 

6.4 Click to choose the alternative where to format  of the data  is “with the symbols in the 

mask…”. 

Type  your  format  (Input  Mask) as 

 “000000-00-0000”. 
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6.5 Click the “Finish” button. 

 
Note:  

You may state in the form created later by using a label “If Malaysia” so that only our 

citizens will need to key in the information of their identity card. 

 

8. Field name: Occupation,  Data type: Text/Lookup Wizard, lookup a table named 

“Occupation” and then save the table. 

8.1 Initially accept the data type as Text. 

8.2 Create a new table named “Occupation” 

8.3 In the design view, accept ID as the default setting. 

8.4 Add a new field named Occupation. 

8.5 Switch to Datasheet View, in the field named “Occupation” , type the values: 

 Agriculture 

 Business 

 Education 

 Finance 

 Manufacturing 
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 Medical 

 Military 

 Service 

 Others 

 
 

8.6 Save and close the new table. 

8.7 Go back to Table1 in design view. In the field named Occupation, click on the data 

type to select Lookup Wizard. Repeat the process until completion. 

 

9. Field name: Salary,  Data type: Currency, use RM as currency unit. 

 
 

Note:  If the “RM” currency unit is not available, you need to set the currency unit in “RM”, 

by carrying out the following steps: 
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9.1 Control Panel > Regional and Language Options > “Regional Option” Tab > Click on 

the “Customize” button. 

 
9.2 Type the “RM” symbol into the “Currency symbol” option. 

9.3 Click the “OK” button. 

 
The currency unit in “RM” should be available. 
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10. Field name: Loan_Amount,  Data type: Currency. Impose validation rule. 

 
In the Field Properties panel, type in the validation rule and the validation text. 

 

11. Field name: Term_of_payment,  Data type: Numbers. Impose validation rule 

 
In the Field Properties panel, type in the validation rule and the validation text. 

 

 

12. Field name: Address1,  Data type: Text.  

Field properties: Required. Field size: 100. 

 

13. Field name: Town,  Data type: Text. 

Field properties: Required. Field size: 40. 

 

Loan_Amount 
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14. Field name: State,  Data type: Text/ Lookup Wizard, lookup a table named “State”. 

 

14.1 Let the field name “State” with the default data type as “text”. Create a new 

table named “State”. 

14.2 In the Design View,  accept field named ID as default and add a new field 

named “State”. 

14.3 In  the Datasheet View, key in the details. 

  
14.4 Save and close the table. 

14.5 Back Table1, in the data type column, choose “Lookup Wizard” to lookup to 

the table named “States”. 

 

15. Field name: Phone_number,  Data type: Text with input mask 

Note:  You  may ignore the input mask properties so that the users may key in data in any 

format. 
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15.1 In the Field Properties panel, click on the row besides the field “Input Mask”.

 
 

15.2   Select “Phone_Number” and click the “Next >” button.

 
 

Phone_number 
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15.3 Type the format required in the field of “Input Mask”.

 
 

15.4  Select “...to store data … with the symbols in the mask..” 

 
 

15.5   Click the “Finish” button. 
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16. Field name: Photograph,  Data type: Attachment. 

 
 

Choose the data type as “Attachment”. 

 

17. Field name: Attachment,  Data type: Attachment. 

Repeat the same procedure as above. 
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II. Create a Form 
 

Let’s choose  the  automated-form creation tool to create a simple form. 

1. In the navigation panel on the left, highlight the main table which contains all the fields 

which you have created. 

2. On the menu bar, “Create” Tab > “Forms” group tools > click “Form”. 

3. Change the formatting and add labels to clarify the required some of the fields such as the 

format for the BirthDate,  Term_of_payment in years, etc. 
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3a. Alternative 1: In Layout View  
The simplest way to alter the layout is to switch to Layout View. 

By default, all the fields are stacked as a single unit. If you try to resize one column, the other 

column will also be affected. 

i.   

The “stacked effect” means that all the fields are group collectively a one unit. 

 

ii.  

When you try to resize any field, the sizes of all the other fields will be changed, too. 
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You may have remove the “stacked” effect through the following steps: 

1. Click on the handle of the form to select the fields which were stacked as a single unit.

 

2. On the contextual tab “Form Layout Tools”, under the “Control Layout” group tools, click to 

choose the “Remove” button. 
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The yellow colour  (highlight) indicates that the fields are selected. 

 

You may move and resize individual field freely for they are no longer bound as one unit. 

 
 

 



MS  Access  2007 - Field  Validation  Rules                     
 

Sharing from Sumitra Kan Fong Kuen, Jabatan Teknologi Pendidikan, IPGKTHO Page 26 
 

3b. Alternative 2: In Design View  
Another alternative is to do the alteration in the Design View. Do include explanation to 

assist the users for keying in the required information. 

 
Note:  

You may use the “Label” button to create a label (to include a statement or guide in the 

form). 

 Procedure: Form Design Tools > Design  Tab > Controls Group Tool > Click “Label” 

button. 

 
 Place the label on the desired location and type your text. 
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Save the form. Close the form object. 

III. Testing the Validation Rules 
 

A. Testing  the  field  validation  rules  in  Design  View. 

Condition:  You need to open the table in Design View and it had already contained multiple 

records. 

1. Open the table that contains your validation rules in Design View. 
2. On the Design tab, in the Tools group, click Test Validation Rules. 

 



MS  Access  2007 - Field  Validation  Rules                     
 

Sharing from Sumitra Kan Fong Kuen, Jabatan Teknologi Pendidikan, IPGKTHO Page 28 
 

3. Click Yes to close the alert message and start the test. 

 

4. If prompted to save your table, Click Yes. 
5. You might see a variety of other alert messages as you proceed. Read the instructions in 

each message, and then click Yes or No, as appropriate, to complete or stop the testing. 

 

 

 

B. Testing the validation rules while entering the data 

1. Reopen the form. 

2. Try keying in the data, and do try to enter the wrong data type or format and see the 

effect of validation rules and the display of the validation text. 

 

“A man's errors are his portals of discovery.”  

James Joyce 

 

May  you  enjoy  this  sharing  session. 

Thank  you! 
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